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1 INTRODUCTION

1.1 CAUTIONS

CAUTION
The GPS system is operated by the government of the United States, which is solely responsible for its accuracy and
maintenance. Although the GPS 17x HVS is a precision electronic NAVigation AID (NAVAID), any NAVAID can
be misused or misinterpreted, and therefore become unsafe. Use these products at your own risk. To reduce the risk,
carefully review and understand all aspects of these Technical Specifications before using the GPS 17x HVS. When
in actual use, carefully compare indications from the GPS to all available navigation sources including the
information from other NAV AIDs, visual sightings, charts, etc. For safety, always resolve any discrepancies before
continuing navigation.

FCC
Compliance
This product has been tested and found to comply with Part 15 of the FCC interference limits for Class B digital

devices FOR HOME OR OFFICE USE. These limits are designed to provide more reasonable protection against
harmful interference in a residential installation, and are more stringent than “outdoor” requirements.

Operation of this device is subject to the following conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause undesired operation.

This equipment generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications if not installed and used in accordance with the instructions. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and the receiver.

e Connect the equipment into an outlet that is on a different circuit from the GPS unit.
e  Consult the dealer or an experienced radio/TV technician for help.

This product does not contain any user-serviceable parts. Repairs should only be made by an authorized Garmin®
service center. Unauthorized repairs or modifications could result in permanent damage to the equipment, and void
your warranty and your authority to operate this device under Part 15 regulations.

190-00885-07 GPS 17x HVS Technical Specifications Rev.B
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1.2 LIMITED WARRANTY

This Garmin product is warranted to be free from defects in materials or workmanship for one year from the date of
purchase. Within this period, Garmin will, at its sole option, repair or replace any components that fail in normal
use. Such repairs or replacement will be made at no charge to the customer for parts or labor, provided that the
customer shall be responsible for any transportation cost. This warranty does not apply to: (i) cosmetic damage, such
as scratches, nicks and dents; (ii) consumable parts, such as batteries, unless product damage has occurred due to a
defect in materials or workmanship; (iii) damage caused by accident, abuse, misuse, water, flood, fire, or other acts
of nature or external causes; (iv) damage caused by service performed by anyone who is not an authorized service
provider of Garmin; or (v) damage to a product that has been modified or altered without the written permission of
Garmin. In addition, Garmin reserves the right to refuse warranty claims against products or services that are
obtained and/or used in contravention of the laws of any country.

This product is intended to be used only as a travel aid and must not be used for any purpose requiring precise
measurement of direction, distance, location or topography. Garmin makes no warranty as to the accuracy or
completeness of map data in this product.

THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN LIEU OF ALL
OTHER WARRANTIES EXPRESS, IMPLIED, OR STATUTORY, INCLUDING ANY LIABILITY ARISING
UNDER ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE,
STATUTORY OR OTHERWISE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, WHICH MAY
VARY FROM STATE TO STATE.

IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR ANY TRAFFIC
FINES OR CITATIONS, WHETHER RESULTING FROM THE USE, MISUSE OR INABILITY TO USE THE
PRODUCT OR FROM DEFECTS IN THE PRODUCT. SOME STATES DO NOT ALLOW THE EXCLUSION
OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY
TO YOU.

Garmin retains the exclusive right to repair or replace (with a new or newly-overhauled replacement product) the
device or software or offer a full refund of the purchase price at its sole discretion. SUCH REMEDY SHALL BE
YOUR SOLE AND EXCLUSIVE REMEDY FOR ANY BREACH OF WARRANTY.

To obtain warranty service, contact your local Garmin authorized dealer or call Garmin Product Support for
shipping instructions and an RMA tracking number. Securely pack the device and a copy of the original sales
receipt, which is required as the proof of purchase for warranty repairs. Write the tracking number clearly on the
outside of the package. Send the device, freight charges prepaid, to any Garmin warranty service station.

Online Auction Purchases: Products purchased through online auctions are not eligible for warranty coverage.
Online auction confirmations are not accepted for warranty verification. To obtain warranty service, an original or
copy of the sales receipt from the original retailer is required. Garmin will not replace missing components from any
package purchased through an online auction.

International Purchases: A separate warranty may be provided by international distributors for devices purchased
outside the United States depending on the country. If applicable, this warranty is provided by the local in-country
distributor and this distributor provides local service for your device. Distributor warranties are only valid in the area
of intended distribution. Devices purchased in the United States or Canada must be returned to the Garmin service
center in the United Kingdom, the United States, Canada, or Taiwan for service.

Garmin’s Marine Warranty Policy: Certain Garmin Marine products in certain areas have a longer warranty
period and additional terms and conditions. Go to www.garmin.com/support/warranty.html for more details and to
see if your product is covered under Garmin’s Marine Warranty Policy.
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1.3 OVERVIEW

The GPS 17x HVS is an embedded receiver and an antenna. Based on the proven technology found in other Garmin
GPS receivers, the GPS 17x HVS tracks multiple satellites at a time while providing fast time-to-first-fix, precise
navigation updates once per second, and low power consumption. This generation of GPS sensors includes the
capability of FAA Wide Area Augmentation System (WAAS) differential GPS.

The GPS 17x HVS design uses the latest technology and high-level circuit integration to achieve superior
performance while minimizing space and power requirements. The hardware capability combined with software
intelligence makes the GPS 17x HVS easy to integrate and use.

The GPS 17x HVS is designed to withstand rugged operating conditions and is waterproof to IEC 60529 IPX7:
immersion in 1 meter of water for 30 minutes. The complete GPS receiver requires minimal additional components
to be supplied by an OEM or system integrator. A minimum system must provide the GPS with a source of power
and a clear view of the GPS satellites. Internal FLASH memory allows the GPS to retain critical data such as
satellite orbital parameters, last-known position, date and time. End user interfaces such as keyboards and displays
are the responsibility of the application designer.

1.4 FEATURES

e  GPS receiver tracks and uses multiple satellites for fast, accurate positioning and velocity estimates.

e Differential DGPS capability using real-time WAAS corrections yielding position errors of less than 3
meters.

e  Compact, rugged design ideal for applications with minimal space.

e Factory configuration meets the needs of most systems that expect NMEA 0183 data from a GPS receiver.
Configuration commands are available to customize the NMEA 0183 output (see section 4.1 Received
NMEA 0183 Sentences)

e Highly accurate measurement pulse output for precise timing measurements: one-pulse-per-second (1 Hz).
Pulse width is configurable in 20 millisecond increments from 20 ms to 980 ms with 1 ps accuracy.

e Configurable for binary format data output.

e FLASH-based program allows new software revisions through a Web site download.

¢ Non-volatile memory does not require battery backup.

e  Onboard rechargeable backup battery can maintain the real-time clock for up to 10 days.

e Configurable parameters include expected position, current time and date, and preferred position fix type
(3D or automatic).

e  Waterproof design allows continuous exposure to the prevailing weather conditions at most locations.

190-00885-07 GPS 17x HVS Technical Specifications Rev.B
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1.5 GPS 17X SERIES

1.5.1

GPS 17x HVS

The GPS 17x HVS interfaces to a RS-232 serial port of a
computer via a DB-9 connector and receives power through a
vehicle power adapter. The GPS 17x is RS-422 compatible.
See the wiring diagrams for correct wiring.

The GPS 17x HVS can cause an issue with Microsoft”
Windows" operating systems if the DB9 connector is plugged
into the computer before the computer is fully running. The
Windows operating system may interpret the serial connector
on the GPS 17x HVS as a serial mouse. Please refer to
Appendix D: GPS 17x HVS & Window Serial Mouse Issue
for complete details.

1.5.2

GPS 17x NMEA 2000

The GPS 17x is also available with an NMEA 2000 interface.
See www.garmin.com/oem for details.

1.6 TECHNICAL SPECIFICATIONS

The following specifications are for the GSP 17x HVS. Specifications are subject to change without notice.

1.6.1
1.6.1.1

1.6.1.2

1.6.1.3

1.6.1.4

1.6.1.5

1.6.2
1.6.2.1

1.6.2.2

1.6.2.3

1.6.2.4

1.6.2.5

Physical Characteristics
Size
3 "%/, in. (96.1 mm) in diameter and 1 '*/;4 in. (49.5 mm) in height

Weight
7.1 0z. (201 g)

Color
White

Case Material
Fully gasketed high-impact plastic alloy, waterproof to IEC 529 IPX7 standards

Cable Length
30 ft. (9.14 m)

Electrical Characteristics
Input Voltage
8-33 Vdc

Input Current
40 mA @ 12 Vdc

CMOS Serial Output Levels
0 Vdc to 3.3 Vdc (Differential NMEA 0183 Serial, Compatible Polarity)

GPS Receiver Sensitivity
-185 dBW minimum

Environmental Characteristics
Operating Temperature: -22°F to +176°F (-30°C to +80°C)

Storage Temperature: -40°F to +194°F (-40°C to +90°C)
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1.6.3
1.6.3.1

GPS Performance

Receiver

WAAS Enabled® GPS receiver continuously tracks and uses multiple satellites to compute and update your position.

1.6.3.2

1.6.3.3

1.6.3.4

1.6.4
1.6.4.1

1.6.4.2

Acquisition Times

Reacquisition:  Less than 2 seconds

Hot: Approx. 1 second (all data known)
Warm: Approx. 38 seconds (initial position, time, and almanac known; ephemeris unknown)
Cold: Approx. 45 seconds

Update Rate

1 record per second

Accuracy

GPS Standard Positioning Service (SPS)

Position: < 15 meters, 95% typical
Velocity: 0.1 knot RMS steady state
WAAS/EGNOS/MSAS

Position: < 3 meters, 95% typical

Velocity: 0.1 knot RMS steady state

Measurement Pulse Output Time: £1 microsecond at rising edge of the pulse

Dynamics: 999 knots velocity (only limited at altitude greater than 60,000 feet), 2g dynamics

Interfaces

GPS 17x HVS Electrical Characteristics
Differential NMEA 0183 Serial, Compatible Polarity. Default setting is 4800 baud.

Garmin Interface

Refer to the Garmin Device Interface Specification found in the Garmin Device Interface SDK for information
about the Garmin Interface. At the time of this printing, this document is located on the Garmin Web site at:
www.garmin.com/support/commProtocol.html.

1.6.4.3

GPS 17x HVS Protocol
NMEA 0183 Version 3.01 (the factory default version) is programmable by data field 7 of the PGRMCI1
sentence described in section 4.1.4 Additional Sensor Configuration Information (PGRMC1).

Available NMEA 0183 output sentences include GPALM, GPGGA, GPGSA, GPGSV, GPRMC, GPVTG,
GPGLL, PGRME, PGRMF, PGRMM, PGRMT, PGRMV, and PGRMB (Garmin proprietary sentences).
See section 4.2 Transmitted NMEA 0183 Sentences for format descriptions.

Configuration and initialization is accomplished with NMEA 0183 input sentences. Allows initialization of
information such as expected position, date, time, earth datum, and differential mode. See section 4.1
Received NMEA 0183 Sentences for format descriptions.

Configurable for binary data output.

1.6.4.4 Measurement Pulse Output
e 1 Hz pulse with programmable width, configurable in 20 ms increments from 20 ms to 980 ms. See section
4.1.3 Sensor Configuration Information (PGRMC) for details about configuring the Measurement Pulse
Output (or PPS) feature.
e 1 usaccuracy for all conditions in which the GPS 17x HVS reported a valid and accurate position fix for at
least the previous 4 seconds.
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2 GPSX 17X HVS WIRING AND PINOUTS

The GPS 17x HVS interfaces to a serial port. The unit accepts TIA-232-F (RS-232) level inputs and transmits
voltage levels from ground 3.3 V, TIA-422 (RS-422) polarity.

21 GPS 17X HVS PINOUT

GPS 17x HVS Color Signal Name Wire Gauge
Pin #
1 White Receive Data A 22
2 Black Ground 22
3 Red VIN 22
4 Orange Accessory On 22
5 White/Red Transmit Data B 22
6 Gray Transmit Data A 22
7 White/Orange Receive Data B 22
8 Violet Pulse Per Second (PPS) 22

Table 1: GPS 17x HVS Pinout

2.2 GPS 17X HVS WIRING DIAGRAMS

4 GPS 17x HVS
() () Fuse  Computer Serial Port
e AR Interconnection

([ O Pin 5: Ground Red: Vin

Black: GND

910 5|4 _ RXB GPS 17x HVS
8| O o Pin 3: Data Out RXA
719 Pin 2: Data In TXA
6| O o

1 Accessory ON

O DB-9
Serial Connector (Tﬁonnecte o
(Female Pin Contacts)
Figure 1: Computer Serial Port Interconnection
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\. TXA

® TXB (unconnected)
DB-9 N R
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Figure 2. PDA Serial Port Interconnection
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Rx B(-) Tx B(-)
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Figure 3a. GPS 17x NMEA 0183 HVS Wired for Two-Way Communication

Exceptions:

If your NMEA 0183-compliant device has only one receiving wire (Rx), connect it to the gray wire (Tx/A) from the
GPS 17x antenna, and leave the white/red wire (Tx/B) from the antenna unconnected.

If your NMEA 0183-compliant device has only one transmitting wire (Tx), connect it to the white wire (Rx/A) from
the GPS 17x antenna, and connect the white/orange wire (Rx/B) to ground.

Note: The orange (accessory on) wire is used when wiring the GPS 17x to a Garmin chartplotter, or other NMEA
0183 device that has a defined accessory signal wire. If you are wiring the GPS 17x to a device that does not have an
accessory signal wire, the orange wire from the GPS 17x should be connected to ground.

Caution: If you are wiring the GPS 17x to a device that does not have an accessory signal wire, connect the
GPS 17x power wire to the ignition or install an in-line switch. The GPS 17x can drain the battery of the boat if it is
not switched.
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Color Function Pin

Fuse 1A

Red Power 3
Black Ground 2
Orange ACC On 4
Gray Tx A(+) 6
White/Red Tx B() 5
White Rx A(+) 1
White/Orange Rx B(-) 7

. Pulse Per
Violet Second (PPS) 8

Figure 3b. GPS 17x NMEA 0183 HVS Power/Data Cable

3 MECHANICAL CHARACTERISTICS & MOUNTING

The following drawing shows an example for mounting hardware in case you wish to design your own custom
mount. Figure 4a shows the dimensions of the bottom of the GPS 17x HVS.

®91.57 mm @ 68.00 mm

3X @5.35mm
EQ. SPACED

Figure 4. GPS 17x HVS Bottom Case Dimensions
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4 GPS 17X HVS SOFTWARE INTERFACE

The interface protocol design of the GPS 17x HVS is based on the National Marine Electronics Association’s
NMEA 0183 ASCII interface specification. This standard is fully defined in NMEA 0183, Version 2.30. You can
obtain a copy of the latest specification from NMEA, www.nmea.org.

In addition to the standard NMEA 0183 sentences, the GPS 17x HVS may also be configured to transmit
information over their serial interface using NMEA 0183 compliant Garmin proprietary sentences. These proprietary
sentences begin with the characters, “SPGRM”, instead of the characters “$G” that are typical of the standard
NMEA 0183 sentences. The characters “$P” indicate that the sentence is a proprietary implementation and the
characters and “GRM?” indicate that it is Garmin’s proprietary sentence. The letter (or letters) that follow the
characters “SPGRM” uniquely identifies that particular Garmin proprietary sentence.

It is also possible to configure the GPS 17x HVS to transmit binary data information over their serial interface. See
Appendix B: Garmin Binary Output Format for details.

The following sections describe the NMEA 0183 data format of each sentence transmitted and received by the GPS
17x HVS.

4.1 RECEIVED NMEA 0183 SENTENCES

The following paragraphs define the sentences that can be received on the GPS sensor’s port. Null fields in the
configuration sentence indicate no change in the particular configuration parameter. All sentences received by the
GPS sensor must be terminated with <CR><LF>, the ASCII characters for carriage return (0D hexadecimal) and
line feed (0A hexadecimal). The checksum *hh is used for parity checking data and is not required, but is
recommended for use in environments containing high electromagnetic noise. It is generally not required in normal
PC environments. When used, the parity bytes (hh) are the ASCII representation of the exclusive-or (XOR) sum of
all the characters between the “$” and “*” characters, non-inclusive. The hex representation must be a capital letter,
such as 3D instead of 3d. Sentences may be truncated by <CR><LF> after any data field and valid fields up to that
point will be acted on by the sensor.

4.1.1 Almanac Information (GPALM)

The GPALM sentence can be used to initialize the GPS sensor’s stored almanac information in the unlikely event of
non-volatile memory loss or after storing longer than six months without tracking GPS satellites.

$GPALM,<1>,<2>,<3> <4> <5> <6>,<7>,<8> <9> <10>,<1 1>,<12>,<13>,<14>,<1 5>*hh<CR><LF>

<1> | Total number of ALM sentences to be transmitted by the GPS sensor during almanac download.
This field can be null or any number when sending almanac to the GPS sensor.

<2> | Number of current ALM sentence. This field can be null or any number when sending almanac
to the GPS sensor.

<3> | Satellite PRN number, 01 to 32

<4> | GPS week number

<5> | SV health, bits 17-24 of each almanac page

<6> | Eccentricity

<7> | Almanac reference time

<8> | Inclination angle

<9> | Rate of right ascension

<10> | Root of semi major axis

<11> | Omega, argument of perigee

<12> | Longitude of ascension node

<13> | Mean anomaly

<14> | af0 clock parameter

<15> | afl clock parameter
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Page 9


http://www.nmea.org/�

4.1.2 Sensor Initialization Information (PGRMI)

The PGRMI sentence provides information used to initialize the GPS sensor’s set position and time used for satellite
acquisition. Receipt of this sentence by the GPS sensor causes the software to restart the satellite acquisition process.
If there are no errors in the sentence, it will be echoed upon receipt. If an error is detected, the echoed PGRMI
sentence will contain the current default values. Current PGRMI defaults (with the exception of the Receiver
Command, which is a command rather than a mode) can also be obtained by sending the sentence “$SPGRMIE” to
the GPS sensor.

$PGRMI, <1>,<2>,<3>,<4> <5> <6>,<7>*hh<CR><LF>

<1> | Latitude, ddmm.mmm format for GPS 17x HVS (leading zeros must be transmitted)
<2> | Latitude hemisphere, N or S

<3> | Longitude, ddmm.mmm format for GPS 17x HVS (leading zeros must be transmitted)
<4> | Longitude hemisphere, E or W

<5> | Current UTC date, ddmmyy format

<6> | Current UTC time, hhmmss format for GPS 17x HVS

<7> | Receiver Command, A = Cold Start, R = Unit Reset

4.1.3 Sensor Configuration Information (PGRMC)

The PGRMC sentence provides information used to configure the GPS sensor’s operation. Configuration parameters
are stored in non-volatile memory and retained between power cycles. The GPS sensor will echo this sentence upon
its receipt if no errors are detected. If an error is detected, the echoed PGRMC sentence will contain the current
default values. Current default values can also be obtained by sending the sentence “SPGRMCE” to the GPS sensor.

$PGRMC,<1>,<2>,<3>,<4> <5> <6>,<7>,<8>,<9> <1 0>,<1 1>,<12>,<13>,<14>*hh<CR><LF>

<I> Fix mode, A = Automatic, 3 = 3D exclusively

<2> Altitude above/below mean sea level, -1500.0 to 18000.0 meters

<3> Earth datum index. If the user datum index (96) is specified, fields <4> through <8> must contain
valid values. Otherwise, fields <4> through <8> must be null. Refer to Appendix A: Earth Datum List
for a list of earth datum and the corresponding earth datum index.

<4> User earth datum semi-major axis, 6360000.000 to 6380000.000 meters (.001 meters resolution)

<5> User earth datum inverse flattening factor, 285.0 to 310.0 (10 resolution)

<6> User earth datum delta x earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution)

<7> User earth datum delta y earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution)

<8> User earth datum delta z earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution)

<9> Differential mode, A = Automatic (output DGPS data when available, non-DGPS otherwise), D =
Differential exclusively (output only differential fixes)

<10> | NMEA 0183 Baud rate, 1 = 1200, 2 = 2400, 3 = 4800, 4 = 9600, 5 = 19200, 6 = 300, 7 = 600, 8 =
38400

<l1> Velocity filter, 0 = No filter, 1 = Automatic filter, 2 to 255 = Filter time constant (e.g. 10 = 10 second
filter)

<12> | Measurement Pulse Output, 1 = Disabled, 2 = Enabled

<13> | Measurement Pulse Output pulse length, (n+1)*20 ms
n = 0 through 48 (max. 980 ms)
Example: n = 4 corresponds to a 100 ms wide pulse

<14> | Dead reckoning valid time 1 to 30 sec. for the GPS 17x HVS

All configuration changes take effect after receipt of a valid value except baud rate. Baud rate changes take effect on
the next power cycle or an external reset event.
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4.1.4 Additional Sensor Configuration Information (PGRMC1)

The PGRMCI1 sentence provides additional information used to configure the GPS sensor operation. Configuration
parameters are stored in non-volatile memory and retained between power cycles. The GPS sensor will echo this
sentence upon its receipt if no errors are detected. If an error is detected, the echoed PGRMCI1 sentence will contain
the current default values. Current default values can also be obtained by sending the sentence “SPGRMCIE” to the
GPS sensor.

$PGRMC1,<1>,<2>,<3>,<4> <5> <6> <7> <8><9> <10><11>,<12><13>*hh<CR><LF>

<1> | NMEA 0183 output time 1 to 900 (sec).

<2> | Binary Output Data, 1 = Off, 2 = On.

<3> | Low Velocity Position Filter (1 = Off, 2 = On)

<4> | No Effect (DGPS beacon frequency: 0.0, 283.5 to 325.0 kHz in 0.5 kHz steps)

<5> No Effect (DGPS beacon bit rate: 0, 25, 50, 100, or 200 bps)

<6> | No Effect (DGPS beacon scanning, 1 = Off, 2 = On)

<7> NMEA 0183 version 2.30 mode indicator, 1 = Off, 2 = On

<8> | DGPS WAAS mode, W = WAAS Enabled, N = WAAS Disabled

<9> Power Save Mode, P = Power Save mode, N = Normal

<10> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<11> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<12> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<13> | Measurement Pulse Output Auto Off Mode, 1 = Off, 2 = On

Configuration changes take effect immediately, with the exception of Binary Output Data, which takes effect on the
next power cycle or a reset event. Send the sentence “$PGRMI,,,,,,,R” to command a reset (refer to section 4.1.2
Sensor Information (PGRMI). If the GPS sensor is in the Binary data mode, it is necessary to send the following
eight-byte data stream to temporarily change the data format to NMEA 0183:

10 0A 02 26 00 CE 10 03 (Hexadecimal)

Then send PGRMC1 with field 2 set to turn off the Binary Output Data format.

4.1.5 Output Sentence Enable/Disable (PGRMO)
The PGRMO sentence provides the ability to enable and disable specific output sentences. The following sentences
are enabled at the factory for the GPS 17x HVS: GPGGA, GPGSA, GPGSV, GPRMC, and PGRMT.

$PGRMO,<1>,<2>*hh<CR><LF>

<1> Target sentence description (for example, PGRMT, GPGSV, etc.)

<2> Target sentence mode, where 0 = Disable specified sentence, 1 = enable specified sentence, 2 =
Disable all output sentences, 3 = Enable all output sentences (except GPALM), 4 = Restore factory
default output sentences

The following notes apply to the PGRMO input sentence:

If the target sentence mode is “2” (Disable all), “3” (Enable all), or ‘4’ (Restore defaults), the target sentence
description is not checked for validity. In this case, an empty field is allowed (for example, “$PGRMO,,3”), or the
mode field may contain from 1 to 5 characters.

If the target sentence mode is “0” (Disable) or “1” (Enable), the target sentence description field must be an
identifier for one of the sentences that can be output by the GPS sensor.

If either the target sentence mode field or the target sentence description field is not valid, the PGRMO sentence will
have no effect.

Sending the sentence “$PGRMO,GPALM,1” will cause the GPS sensor to transmit all stored almanac information.
All other NMEA 0183 sentence transmission will be suspended temporarily.

Sending the sentence “$SPGRMO,,G” will cause the COM port to change to Garmin Data Transfer format for the
duration of the power cycle. The Garmin mode is required for GPS 17x HVS series product software updates.
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4.2 TRANSMITTED NMEA 0183 SENTENCES
The subsequent paragraphs define the sentences that can be transmitted by the GPS 17x HVS.

4.2.1 Sentence Transmission Rate
Sentences are transmitted with respect to the user selected baud rate.

The GPS sensor will transmit each sentence (except where noted in particular transmitted sentence descriptions) at a
periodic rate based on the user selected baud rate and user selected output sentences. The GPS sensor will transmit
the selected sentences contiguously. The length of the transmission can be determined by the following equation and
Tables 2 and 3:

total characters to be transmitted

length of transmission =
characters transmitted per second

Sentence Output by Default? Maximum Characters
GPRMC v 74
GPGGA v 82
GPGSA v 66
GPGSV v 70
PGRME 35
GPGLL 44
GPVTG 42
PGRMV 32
PGRMF 82
PGRMB 40
PGRMM

PGRMT Once per minute 50

Table 2: NMEA 0183 Output Sentence Order and Size

Baud Characters per Second
4800 480

9600 960

19200 1920

38400 3840

Table 3: Characters per Second for Available Baud Rates

The maximum number of fields allowed in a single sentence is 82 characters including delimiters. Values in the
table include the sentence start delimiter character “$” and the termination delimiter <CR><LF>. For the GPS 17x
HVS, the factory set defaults result in a once per second transmission at the NMEA 0183 specification transmission
rate of 4800 baud.

Regardless of the selected baud rate, the information transmitted by the GPS sensor is referenced to the one-pulse-
per-second output pulse immediately preceding the GPRMC sentence, or whichever sentence is output first in the
burst (see Table 2 above).
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4.2.2 Transmitted Time

The GPS sensor outputs Coordinated Universal Time (UTC) date and time of day in the transmitted sentences.
Before the initial position fix, the on-board clock provides the date and time of day. After the initial position fix, the
date and time of day are calculated using GPS satellite information and are synchronized with the measurement
pulse output.

The GPS sensor uses information obtained from the GPS satellites to add or delete UTC leap seconds and correct the
transmitted date and time of day. The transmitted date and time of day for leap second correction follow the
guidelines in “National Institute of Standards and Technology Special Publication 432 (Revised 1990)” (for sale by
the Superintendent of Documents, U.S. Government Printing Office, Washington, D.C., 20402, U.S.A.).

When a positive leap second is required, one second is inserted at the beginning of the first hour (Oh Om Os) of the
day that the positive leap is occurring. The minute containing the leap second is 61 seconds long. The GPS sensor
would have transmitted this information for the leap second added December 31, 1998 as follows:

$GPRMC,235959,A,3851.3651,N,09447.9382,W,000.0,221.9,071103,003.3,E*69
$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67
$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67
$GPRMC,000001,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*66

If a negative leap second should be required, one second will be deleted at the end of some UTC month. The minute
containing the leap second will be only 59 seconds long. In this case, the GPS sensor will not transmit the time of
day Oh Om Os (the “zero” second) for the day from which the leap second is removed.

$GPRMC,235959,A,3851.3650,N,09447.9373,W,000.0,000.0,111103,003.3,E*69
$GPRMC,000001,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*6A
$GPRMC,000002,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*69

4.2.3 Global Positioning System Almanac Data (GPALM)

Almanac sentences are not normally transmitted. Send the GPS sensor the sentence “$SPGRMO,GPALM,1” to
initiate almanac transmission. Upon receipt, the GPS sensor will transmit available almanac information on GPALM
sentences. During the transmission of almanac sentences, other NMEA 0183 data output is suspended temporarily.

$GPALM, <1>,<2><3> <4> <5> <6>,<7> <8> <9> <1 0> <] 1>,<12>,<13>,<14> <1 5>*hh<CR><LF>

<field information> can be found in section 4.1.1 Almanac Information (GPALM).
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4.2.4 Global Positioning System Fix Data (GPGGA)
$GPGGA <1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9> M,<10>,M,<1 1>,<12>*hh<CR><LF>

<1> | UTC time of position fix, hhmmss format for GPS 17x HVS

<2> | Latitude, ddmm.mmmm format for GPS 17x HVS (leading zeros will be transmitted)

<3> | Latitude hemisphere, N or S

<4> | Longitude, dddmm.mmmm format for GPS 17x HVS (leading zeros will be transmitted)

<5> | Longitude hemisphere, E or W

<6> | GPS quality indication, 0 = fix not available, 1 = Non-differential GPS fix available, 2 =
Differential GPS (WAAS) fix available, 6 = Estimated

<7> | Number of satellites in use, 00 to 12 (leading zeros will be transmitted)

<8> | Horizontal dilution of precision, 0.5 to 99.9

<9> | Antenna height above/below mean sea level, -9999.9 to 99999.9 meters

<10> | Geoidal height, -999.9 to 9999.9 meters

<11> | Null (Differential GPS)

<12> | Null (Differential Reference Station ID)

4.2.5 GPS DOP and Active Satellites (GPGSA)

$GPGSA,<1>,<2>,<3>,<3>,<3> <3> <3> <3> <3> <3> ,<3> <3> <3> <3> <4> <5> <6>*hh<CR><LF>
<1> | Mode, M = Manual, A = Automatic
<2> | Fix type, 1 = not available, 2 =2D, 3 =3D
<3> | PRN number, 01 to 32, of satellite used in solution, up to 12 transmitted (leading zeros will be
transmitted)
<4> | Position dilution of precision, 0.5 to 99.9
<5> | Horizontal dilution of precision, 0.5 to 99.9
<6> | Vertical dilution of precision, 0.5 to 99.9

4.2.6 GPS Satellites in View (GPGSV)

$GPGSV <1>,<2>,<3>,<4> <5> <6> <T7>,...<4> <5> <6> <7>*hh<CR><LF>
<1> | Total number of GSV sentences to be transmitted
<2> | Number of current GSV sentence
<3> | Total number of satellites in view, 00 to 12 (leading zeros will be transmitted)
<4> | Satellite PRN number, 01 to 32 (leading zeros will be transmitted)
<5> | Satellite elevation, 00 to 90 degrees (leading zeros will be transmitted)
<6> | Satellite azimuth, 000 to 359 degrees, true (leading zeros will be transmitted)
<7> | Signal to noise ratio (C/No) 00 to 99 dB (leading zeros will be transmitted)

Note: Items <4>,<5>,<6>, and <7> repeat for each satellite in view to a maximum of four (4) satellites per sentence.
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4.2.7 Recommended Minimum Specific GPS/TRANSIT Data (GPRMC)
$GPRMC, <1><2> <3> <4> <5> <6>,<7>,<8> <9> <10>,<11>,<12>*hh<CR><LF>

<1> | UTC time of position fix, hhmmss format for GPS 17x HVS

<2> | Status, A = Valid position, V = NAV receiver warning

<3> | Latitude, ddmm.mmmm format for GPS 17x HVS (leading zeros must be transmitted)
<4> | Latitude hemisphere, N or S

<5> | Longitude, dddmm.mmmm format for GPS 17x HVS leading zeros must be transmitted)
<6> | Longitude hemisphere, E or W

<7> | Speed over ground, GPS 17x HVS: 000.0 to 999.9 knots (leading zeros will be transmitted)
<> | Course over ground, 000.0 to 359.9 degrees, true (leading zeros will be transmitted)
<9> | UTC date of position fix, ddmmyy format

<10> | Magnetic variation, 000.0 to 180.0 degrees (leading zeros will be transmitted)

<11> | Magnetic variation direction, E or W (westerly variation adds to true course)

<12> | Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous, D =
Differential, E = Estimated, N = Data not valid

4.2.8 Track Made Good and Ground Speed (GPVTG)
$GPVTG,<1>T,<2>M,<3>N,<4> K <5>*hh<CR><LF>

<1> | True course over ground, GPS 17x HVS: 000 to 359 degrees (leading zeros will be transmitted)
<2> | Magnetic course over ground, 000 to 359 degrees (leading zeros will be transmitted)

<3> | Speed over ground, GPS 17x HVS: 000.0 to 999.9 knots (leading zeros will be transmitted)
<4> | Speed over ground, GPS 17x HVS: 0000.0 to 1851.8 kilometers per hour (leading zeros will be
transmitted)

<5> | Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous, D =
Differential, E = Estimated, N = Data not valid

4.2.9 Geographic Position (GPGLL)
$GPGLL,<1>,<2>,<3>,<4> <5> <6>,<7>*hh<CR><LF>

<1> | Latitude, ddmm.mmmm format for GPS 17x HVS (leading zeros must be transmitted)
<2> | Latitude hemisphere, N or S

<3> | Longitude, dddmm.mmmm format for GPS 17x HVS (leading zeros must be transmitted)
<4> | Longitude hemisphere, E or W

<5> | UTC time of position fix, hhmmss format for GPS 17x HVS

<6> | Status, A = Valid position, V= NAV receiver warning

<7> | Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous, D =
Differential, E = Estimated, N = Data not valid

4.2.10 Estimated Error Information (PGRME)
$PGRME,<1>M,<2>M,<3> M*hh<CR><LF>

<1> | Estimated horizontal position error (HPE), 0.0 to 999.9 meters
<2> | Estimated vertical position error (VPE), 0.0 to 999.9 meters
<3> | Estimated position error (EPE), 0.0 to 999.9 meters

4.2.11 GPS Fix Data Sentence (PGRMF)
$PGRMF <1><2> <3> <4> <5> <6> <7><8><9> <10>,<11>,<12>,<13>,<14> <15>*hh<CR><LF>

<1> | GPS week number (0 to 1023)

<2> | GPS seconds (0 to 604799)

<3> | UTC date of position fix, ddmmyy format

<4> | UTC time of position fix, hhmmss format for GPS 17x HVS

<5> | GPS leap second count

<6> | Latitude, ddmm.mmmm format for GPS 17x HVS (leading zeros must be transmitted)
<7> | Latitude hemisphere, N or S

<8> | Longitude, dddmm.mmmm format for GPS 17x HVS (leading zeros must be transmitted)
<9> | Longitude hemisphere, E or W

<10> | Mode, M = Manual, A = Automatic
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<11> | Fix type, 0 =no fix, 1 =2D fix, 2 = 3D fix

<12> | Speed over ground, 0 to 1851 kilometers/hour

<13> | Course over ground, 0 to 359 degrees, true

<14> | Position dilution of precision, 0 to 9 (rounded to nearest integer value)
<15> | Time dilution of precision, 0 to 9 (rounded to nearest integer value)

4.2.12 Map Datum (PGRMM)
The Garmin Proprietary sentence PGRMM gives the name of the map datum currently in use by the GPS sensor.
This information is used by the Garmin MapSource real-time plotting application.

$PGRMM,<1>*hh<CR><LF>

| <1> | Name of map datum currently in use (variable length field, for example, “WGS 84”) |

4.2.13 Sensor Status Information (PGRMT)
The Garmin Proprietary sentence PGRMT gives information concerning the status of the GPS sensor. This sentence
is transmitted once per minute regardless of the selected baud rate.

$PGRMT, <1><2>,<3> <4> <5>,<6>,<7>,<8>,<9>*hh<CR><LF>

<1> | Product, model and software version (variable length field, for example, “GPS 17x HVS VER 2.05”)
<2> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<3> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<4> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<5> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<6> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<7> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<8> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<9> | No Effect (This field is not used on this model and is included only for backwards compatibility)

4.2.14 3D Velocity Information (PGRMV)
$PGRMV <1>,<2> <3>*hh<CR><LF>

<1> | True east velocity, -514.4 to 514.4 meters/second for GPS 17x HVS
<2> | True north velocity, -514.4 to 514.4 meters/second for GPS 17x HVS
<3> | Up velocity, -999.9 to 999.9 meters/second for GPS 17x HVS

4.2.15 DPGS Beacon Information (PGRMB)
Note: The GPS 17x HVS does not support RTCM as a differential source. PGRMB is provided for backwards
compatibility.

$PGRMB,<1>,<2>,<3> <4> <5> K ,<6>,<7>,<8>*hh<CR><LF>

<1> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<2> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<3> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<4> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<5> | Distance to beacon reference station in kilometers

<6> | No Effect (This field is not used on this model and is included only for backwards compatibility)
<7> | DGPS fix source (R = RTCM, W = WAAS, N = Non-DGPS Fix)

<@> | DGPS mode, A = Automatic, W = WAAS Only, R = RTCM Only, N = None (DGPS disabled)

4.3 BAUD RATE SELECTION

Baud rate selection can be performed by sending the appropriate configuration sentence to the GPS sensor as
described in the PGRMC section 4.1.2 Sensor Initialization Information (PGRMI), field <10>.

4.4 MEASUREMENT PULSE OUTPUT

4.41 One-Pulse-Per-Second (PPS) Output

The highly accurate one-pulse-per-second (PPS) output is provided for applications requiring precise timing
measurements. After the initial position fix has been calculated, the PPS signal is generated and continues until the
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unit is powered down. The rising edge of the signal is aligned to the start of each GPS second within 1 us for all
conditions in which the receiver has reported a valid and accurate position for at least the previous 4 seconds.

The NMEA 0183 sentences that follow each rising edge of the PPS signal tell when you were and where you were at
that previous rising edge of the PPS signal, beginning with the GPRMC sentence as the lead sentence in any
particular NMEA 0183 record.

Regardless of the selected baud rate, the information transmitted by the GPS 17x HVS is referenced to the pulse
immediately preceding the NMEA 0183 RMC sentence.

The accuracy of the one-pulse-per-second output is maintained only while the GPS receiver is computing a valid
position fix. To obtain the most accurate results, the one-pulse-per-second output should be calibrated against a local
time reference to compensate for cable and internal receiver delays and the local time bias.

The default pulse width is 100 ms, however; it may be programmed in 20 ms increments between 20 ms and 980 ms
as described in PGRMC section 4.1.2 Sensor Initialization Information (PGRMI), field <13>.
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APPENDIX A: EARTH DATUM LIST

The following is a list of the Garmin GPS 17x HVS Earth datum indices and the corresponding earth datum name
(including the area of application):

0 ADINDAN-Ethiopia, Mali, Senegal, Sudan

9 AUSTRALIAN GEODETIC 1984—Australia, Tasmania Island

10 ASTRO DOS 71/4-St. Helena Island

11 ASTRONOMIC STATION 1952—Marcus Island

12 ASTRO B4 SOROL ATOLL-Tern Island

13 BELLEVUE (IGN)-Efate and Erromango Islands

14 BERMUDA 1957-Bermuda Islands

15 BOGOTA OBSERVATORY—-Colombia

16 CAMPO INCHAUSPE-Argentina

17 CANTON ASTRO 1966—-Phoenix Islands

18 CAPE CANAVERAL-Florida, Bahama Islands

19 CAPE—-South Africa

20 CARTHAGE-Tunisia

21 CHATHAM 1971—Chatham Island (New Zealand)

22 CHUA ASTRO-Paraguay

23 CORREGO ALEGRE-Brazil

24 DJAKARTA (BATAVIA)-Sumatra Island (Indonesia)

25 DOS 1968-Gizo Island (New Georgia Islands)

26 EASTER ISLAND 1967—Easter Island

27 EUROPEAN 1950-Austria, Belgium, Denmark, Finland, France, Germany, Gibraltar, Greece, Italy,
Luxembourg, Netherlands, Norway, Portugal, Spain, Sweden, Switzerland

28 EUROPEAN 1979-Austria, Finland, Netherlands, Norway, Spain, Sweden, Switzerland

29 FINLAND HAYFORD 1910-Finland

30 GANDAIJIKA BASE-Republic of Maldives

31 GEODETIC DATUM 1949—New Zealand

32 ORDNANCE SURVEY OF GREAT BRITAIN 1936-England, Isle of Man, Scotland, Shetland Islands,
Wales

33 GUAM 1963—Guam Island

34 GUX 1 ASTRO-Guadalcanal Island

35 HJORSEY 1955-Iceland

36 HONG KONG 1963-Hong Kong

37 INDIAN-Bangladesh, India, Nepal

38 INDIAN-Thailand, Vietnam

39 IRELAND 1965—Ireland

40 ISTS O73 ASTRO 1969-Diego Garcia

41 JOHNSTON ISLAND 1961-Johnston Island

42 KANDAWALA-Sri Lanka

43 KERGUELEN ISLAND-Kerguelen Island
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44 KERTAU 1948—West Malaysia, Singapore

45 L.C. 5 ASTRO-Cayman Brac Island

46 LIBERIA 1964-Liberia

47 LUZON-Mindanao Island

48 LUZON-Phillippines (excluding Mindanao Island)
49 MAHE 1971-Mahe Island

50 MARCO ASTRO-Salvage Islands

51 MASSAW A—Eritrea (Ethiopia)

52 MERCHICH-Morocco

53 MIDWAY ASTRO 1961-Midway Island

54 MINNA-Nigeria

55 NORTH AMERICAN 1927-Alaska

56 NORTH AMERICAN 1927-Bahamas (excluding San Salvador Island)

57 NORTH AMERICAN 1927—Central America (Belize, Costa Rica, El Salvador, Guatemala, Honduras,
Nicaragua)

58 NORTH AMERICAN 1927—Canal Zone
59 NORTH AMERICAN 1927—Canada (including Newfoundland Island)

60 NORTH AMERICAN 1927—Caribbean (Barbados, Caicos Islands, Cuba, Dominican Republic, Grand
Cayman, Jamaica, Leeward Islands, Turks Islands)

61 NORTH AMERICAN 1927-Mean Value (CONUS)

62 NORTH AMERICAN 1927—Cuba

63 NORTH AMERICAN 1927-Greenland (Hayes Peninsula)
64 NORTH AMERICAN 1927-Mexico

65 NORTH AMERICAN 1927-San Salvador Island

66 NORTH AMERICAN 1983—Alaska, Canada, Central America, CONUS, Mexico
67 NAPARIMA, BWI-Trinidad and Tobago

68 NAHRW AN-Masirah Island (Oman)

69 NAHRWAN-Saudi Arabia

70 NAHRWAN-United Arab Emirates

71 OBSERVATORIO 1966—Corvo and Flores Islands (Azores)
72 OLD EGYPTIAN-Egypt

73 OLD HAWAIIAN-Mean Value

74 OMAN-Oman

75 PICO DE LAS NIEVES—Canary Islands

76 PITCAIRN ASTRO 1967-Pitcairn Island

77 PUERTO RICO-Puerto Rico, Virgin Islands

78 QATAR NATIONAL-Qatar

79 QORNOQ-South Greenland

80 REUNION-Mascarene Island

81 ROME 1940-Sardinia Island

82 RT 90-Sweden
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83 PROVISIONAL SOUTH AMERICAN 1956—-Bolivia, Chile, Colombia, Ecuador, Guyana, Peru, Venezuela

84 SOUTH AMERICAN 1969—-Argentina, Bolivia, Brazil, Chile, Colombia, Ecuador, Guyana, Paraguay,
Peru, Venezuela, Trinidad and Tobago

85 SOUTH ASIA-Singapore

86 PROVISIONAL SOUTH CHILEAN 1963—South Chile

87 SANTO (DOS)-Espirito Santo Island

88 SAO BRAZ-Sao Miguel, Santa Maria Islands (Azores)

89 SAPPER HILL 1943—East Falkland Island

90 SCHWARZECK—-Namibia

91 SOUTHEAST BASE-Porto Santo and Madeira Islands

92 SOUTHWEST BASE—Faial, Graciosa, Pico, Sao Jorge, and Terceira Islands (Azores)

93 TIMBALALI 1948-Brunei and East Malaysia (Sarawak and Sabah)

94 TOKYO-Japan, Korea, Okinawa

95 TRISTAN ASTRO 1968-Tristan da Cunha

96 User defined earth datum

97 VITI LEVU 1916-Viti Levu Island (Fiji Islands)

98 WAKE-ENIWETOK 1960-Marshall Islands

99 WORLD GEODETIC SYSTEM 1972

100 WORLD GEODETIC SYSTEM 1984

101 ZANDERIJ-Surinam

102 CH-1903—Switzerland

103 Hu-Tzu-Shan

104 Indonesia 74

105 Austria

106 Potsdam

107 Taiwan—modified Hu-Tzu-Shan

108 GDA-Geocentric Datum of Australia

109 Dutch
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APPENDIX B: GARMIN BINARY OUTPUT FORMAT

In Binary Output mode, the GPS 17x HVS will transmit packets once per second. The record is sent at a default
baud rate of 9600 baud, 8 data bits, and no parity.

To turn this record on, use the PGRMC1 NMEA sentence as described in section 4 GPS 17x HVS Software
Interface. Refer to the Garmin Device Interface Specification found in the Garmin Device Interface SDK for details
on how to form and parse Garmin packets. At the time of this printing, these specs are available from the technical
suppport section of our Web site: www.garmin.com/support/commProtocol.html.

Records sent over RS-232 begin with a delimiter byte (10 hex). The second byte identifies the record type (33 hex
for a position record, 34 hex for a receiver measurement and 72 hex for a satellite data record). The third byte
indicates the size of the data. The fourth byte is the first byte of data. The data is then followed by a checksum byte,
a delimiter byte (10 hex), and an end-of-transmission character (03 hex). Additionally, any DLEs (0x10) that appear
between the delimeters are escaped with a second DLE. There is sample code at the end of this section that will strip
off the DLEs and ETXs.

RS-232 Packet:

- 0x10 (DLE is first byte)

- Ox## (Record ID — single byte)

- Ox## (Number of data bytes — single byte)

- data bytes (See descriptions below)

- Ox## (2’s complement of the arithmetic sum of the bytes between the delimiters)
- 0x10 (DLE)

- 0x03 (ETX is last byte)

The data bytes of each packet contain the record specified by the record ID. A description of each record follows.
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Satellite Data Record
The satellite data has a record ID of 0x72 with 84 (0x54) data bytes. The data bytes contain data for 12 satellites as
described below.

typedef struct

{

uint8 svid; //space vehicle identification (1-32 and 33-64 for
SBAS (WAAS/EGNOS/MSAS) )

uintle6 snr; //signal-to-noise ratio

uint8 elev; //satellite elevation in degrees

uintlé6 azmth; //satellite azimuth in degrees

uint8 status; //status bit-field

} cpo_sat data;

The status bit field represents a set of booleans described below:

Bit Meaning when bit is one (1)
The unit has ephemeris data for the specified satellite.

The unit has a differential correction for the specified satellite.
The unit is using this satellite in the solution.

N|—|O

This pattern is repeated for 12 satellites for a total of 12 X 7 bytes = 84 (0x54) bytes.
The RS-232 Packet for the Satellite Record looks like:

- 0x10 (DLE is first byte)

- 0x72 (Record ID — single byte)

- 0x54 (Number of data bytes — single byte)

- 12 cpo_sat_data records

- Ox## (2’s complement of the arithmetic sum of the bytes between the delimiters)

- 0x10 (DLE)

- 0x03 (ETX is last byte)
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Position Record

The Position Record has a record identifier of
typedef struct

{

float alt;
float epe;
float eph;
float epv;

int fix;
double gps_tow;
double lat;
double lon;
float lon vel;
float lat vel;
float alt vel;
float msl hght;
int leap sec;
long grmn_days;

} cpo_pvt data;

alt Ellipsoid altitude (meters)

epe Estimated position error (meters)

eph Position error, horizontal (meters)

epv Position error, vertical (meters)

fix 0 =no fix; 1 =no fix; 2 = 2D; 3 = 3D; 4 = 2D differential; 5 = 3D differential,

6 and greater = not defined
gps_tow GPS time of week (sec)

lat Latitude (radians)

lon Longitude (radians)

lon_vel Longitude velocity (meters/second)
lat_vel Latitude velocity (meters/second)
alt vel Altitude velocity (meters/second)

msl_hght  Height (mean sea level) (meters)
leap_sec UTC leap seconds
grmn_days Garmin days (days since December 31, 1989)
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DLE and ETX bytes:

Sample C code to receive the two records should filter DLE and ETX bytes as described below:

typedef enum
{
DAT,
DLE,
ETX
} rx state type;

/* Declare and initialize static variables */
static char in quel[ 256 ];
static int in que ptr = 0;
static rx state type rx state = DAT;

void add to que( char data )
{

#define DLE BYTE 0x10
#define ETX BYTE 0x03

if ( rx state == DAT )
{
if ( data == DLE BYTE )
{
rx state = DLE;
}

else
{
in que[ in _gque ptr++ ] = data;
}

}

else if ( rx state == DLE )
{
if ( data == ETX BYTE )

{
rx state = ETX;

}

else

{
rx _state = DAT;

in que[ in_que ptr++ ] = data;
}
}
else if ( rx state == ETX )
{
if ( data == DLE BYTE )

{
rx state = DLE;

}
}

if ( in gque ptr > 255 )
{
in que ptr = 0;
}
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APPENDIX C: CHANGING THE BAUD RATE IN GARMIN MODE

In certain cases, you may need to change the default baud rate of your Garmin GPS receiver while in Garmin mode.
Follow these steps to temporarily change the baud rate.

Refer to the Garmin Device Interface Specification found in the Garmin Device Interface SDK for details on how to
form and parse Garmin packets. At the time of this printing, these specs are available from the technical suppport
section of our Web site: www.garmin.com/support/commProtocol.html.

1. Turn off all requests by transmitting packet:
id =I0P_RQST _DATA (0x1C)
data = 0 (16-bit unsigned integer )
2. The GPS unit will respond by sending a packet with id = IOP_ACK_BYTE (0x06)
3. After you receive the above packet, transmit packet:
id=10P BAUD RQST DATA (0x30)
data = baud rate to change to (32-bit unsigned integer; for example, 38400)
4. The GPS unit will respond by sending a packet:
id=10P BAUD ACPT DATA (0x31)

data = highest acceptable baud rate closest to what was requested
(32-bit unsigned integer; for example, 38361 decimal)

5. Determine the actual baud rate value from the data sent in step 4. This value will be within +/- 5% of the actual
baud rate. (For example, the GPS unit might send a baud rate of 38361, which correlates to a baud rate of
38400).

6. If the baud rate in step 5 is acceptable, transmit packet:
id=10P_ACK BYTE (0x06)
data=10P_BAUD ACPT DATA (0x31)

7. Sleep for a small amount of time, about 100 milliseconds, to make sure the packet in (6) was successfully
transmitted to the GPS unit.

8.  Close the current connection to the GPS unit and immediately open a new connection with the new baud rate
obtained in step 5.

9. Immediately after establishing a connection, transmit packet:
id =10P_CMND DATA (0x0A)
data=10P_ACK PING (0x3A)

10. The GPS will respond by sending a packet:
id=10P_ACK BYTE (0x06)
data=1OP_CMND DATA (0x0A)

11. After you receive the above packet, transmit the same packet in step 9 again.
id=10P_CMND DATA (0x0A)
data =10P_ACK PING (0x3A)

12. The GPS will respond again with the same packet in step 10.
id=10P_ACK BYTE (0x06)
data=10P_CMND DATA (0x0A)

13. The baud rate has been successfully changed upon receiving the above packet. If the GPS unit does not receive
these two IOP_ CMND_ DATA packets within two seconds, it will reset its baud rate to 9600.
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APPENDIX D: GPS 17X HVS AND WINDOWS SERIAL MOUSE ISSUE

Problem: It is possible for Windows to incorrectly interpret the NMEA 0183 output of the GPS 17x HVS as the
output of a Microsoft Serial BallPoint Mouse. When that happens, Windows loads drivers for the Serial BallPoint
Mouse. This causes the cursor to move erratically about the display, clicking, right-clicking, double-clicking,
dragging and dropping displayed items as it goes. On Windows 2000 and Windows XP, you may not experience the
problem if you wait until after the computer is booted before connecting the GPS 17x HVS to the serial
communications port. This problem is not specific to the GPS 17x HVS. Any NMEA 0183 device connected to a
Windows computer’s serial port is likely to cause this problem. Below are several possible solutions to this problem.

If you wish to use a different navigation software application with your GPS 17x HVS, you will need to de-select
the “Binary Output Data” option that is discussed in Solution 3 below.

Solution 1: The easiest solution is to disable the Serial BallPoint mouse in the Device Manager. This solution
assumes that you do not need to use a Serial BallPoint mouse with your computer. When erratic mouse movements
occur, follow the steps below.

1. Unplug the DB9 connector.

2. Right-click the My Computer icon on your desktop and select Properties to open Device Manager.
3. Go to the hardware tab of the resulting pop-up window and click on the Device Manager button.

4. Right-click on Serial BallPoint Mouse and choose the option to Disable (NOT uninstall) this device.

Solution 2: Do not plug the DB9 connector into the computer until the computer is turned on and the operating
system is completely booted up and running. Every time you use the GPS 17x HVS, you will need to start the
computer and operating system before making the connection between the GPS 17x HVS and the computer. This
solution usually works on Windows 2000 and Windows XP computers.

Solution 3: Change the default output of the GPS 17x HVS so that it does not automatically send NMEA 0183 data
to the computer (change the default configuration to enable “Binary Output Data”). Use the Garmin Sensor
Configuration Software, named SNSRXCFG.EXE, provided on the Web site to enable “Binary Output Data.” To
download the software, start at www.garmin.com/oem, select the GPS 17x HVS, and then select Updates and
Downloads.

Please note that by enabling “Binary Output Data,” the device will no longer appear as a NMEA 0183 device to your
computer. As a result, mapping applications that expect to hear NMEA 0183 data will not recognize your GPS 17x
HVS until you re-enable the NMEA 0183 output, disabling the “Binary Output Data” in the process.

Refer to Appendix E: Sensor Configuration Software for complete information about downloading the Sensor
Configuration Software application.

After the Sensor Configuration Software is installed and running on your computer, follow the steps below to
change the default data output of the GPS 17x HVS.

1. Select GPS 17x from the list of sensors and click OK. The
Sensor Configuration Software opens with the default
configuration file for the GPS 17x HVS, as shown on the next
— Base Model
page.
2. Select Config > Switch to NMEA Mode (or press the F10 key). obie i Beltil " GPS 162

SEAE00 Se Vou
connecting toY

3. Select Comm > Setup to open the Comm Setup Window.

" GPS 18k PCAMWC

" GPS 18:-5Hz
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4. Select the serial port to which the GPS 17x
HVS is connected. Select Auto to have the
program automatically determine the baud
rate, or select Manual to manually select
the baud rate of the GPS 17x HVS. Click
OK when done.

Comm Setup il

Senal Port:

Baud Rate
i Auto
" Manual

Cancel |

5. Click the Connect icon E[‘)‘, or select
Comm > Connect to connect to the GPS
17x HVS.

6. To view the current programming of the
GPS 17x HVS, select Config > Get
Configuration from GPS (or press the F§
key). The current programming of the GPS
17x HVS is displayed in the window, as
shown on the previous page.

7. Open the Sensor Configuration Window by
pressing the F6 key or selecting Config >
Sensor Configuration.

8. Place a check mark in the box next to
“Binary Output Data” to change the GPS
17x HVS to Garmin Mode. The unit will
keep this change in the programming until
you change it again in the software.

Note: Selecting Config > Switch to
Garmin Mode (or pressing the F11 key)
only changes the unit to work in Garmin
Mode until power is cycled through the
unit again. For a more permanent change,
refer to step 8 above.

9. Click OK.

10. When you are ready to upload the changes
into the GPS 17x HVS, select Config >
Send Configuration to GPS (or press the
F9 key). The new configuration is then
loaded into the GPS 17x HVS.

11. You may disconnect and close the software
when finished. The software configuration
can also be saved for future reference.

= - SNSRCFG - GARMIN Sensor Configuration Software

File Comm Config Wiew Help -

=10l x|

(=] 83|22 = Sl

SHERCTE
FPE 17

Configquration file:
GFZ Base Hodel:
Selected
Sentences:
[z ele Y
FFFIA

FF -3
FFRMC
FERMT

System Configuratien

4800 bp=

0f£f (Hormal Mode])
Phazs Output Data: OFf

Eaud rate:

Power Zawre Hode:

WHER Configuration
WHER 2.30 Hode: DEf
WHEL Ouktput Time: 1 sec
PPZ Configuration
FPPE mode: 1 Hz
FFZ Length: 100 m=ec
FFZ Rutoe OLf: Off

GFf Configquration

Bk omatic
WAAE Only
Butamatic
20.0 sec

Fix mode:

DGFE Heds:
Differential mode:
Dexd Reakon Time:

Latitude: 00" o000t W
000" 00,000 E
200.0 meters

Longitude:
Bltitude:

Earth datwum index: WeE 54

Sensor Configuration

r Systern Configuration

Baud Rate: |1S2DD 'l

[ FowerSave Mode
[ Phase Output Data

— MMEA Configuration

MNMEA Output Time

3

r— Pulze-Per-Second [PPS) Configuration
FPS Length

s

[~ NMEA 2.30 Mode

¥ Pulze Per Second
" PPS Auto Off Mode

Cancel |

r Commands

Frezet Uit
Feset Wonkal
Sef Autelocate

Test ode

FLLE

— GPS Configuration

Fix Mode: lm Dead Reckon
Y alid Time
DGPS Maode: IW."—‘«."—‘«S Orly "I
|3d zeC
Diff Mode I.&utomatic 'I

Laude: [0 [0 NS
Langitude IU DIEI R W

Altitude: 300 meter

Earth D atunn:

IWGS 24 I

A IES?S‘I 37
(0] |298.25?223583

[

1

Dy:
DE:

1l

Refer to Appendix E: Sensor Configuration Software for complete information about downloading the Sensor

Configuration Software application.
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APPENDIX E: SENSOR CONFIGURATION SOFTWARE

SNSRXCFG configures the GPS sensors based on user-selected parameters. Some application features include the
ability to download GPS sensor configuration, maintain different configurations in files, and perform GPS sensor
configurations quickly with the use of one function key.

This section provides a brief overview of the Sensor Configuration Software. Refer to this section when using the

software to configure your Garmin sensor.

Downloading the Sensor Configuration Software

The Garmin Sensor Configuration Software (SNSRXCFG.exe) is available
from the Garmin Web site. To download the software, start at
www.garmin.com/oem, select GPS 17x, and then select Updates and
Downloads. The Garmin Sensor Configuration Software is included in the

software update download.

Selecting a Model

After opening the program (snsrcfg.exe), the Set Base Model to... Window
appears. Select the radio button next to the type of Garmin sensor you are

configuring.

Connecting to the Sensor

Basze Model
Which Garmin

i GPS 16x

SENFON are pou
cohnecting to?

= GPS 18¢ PC/AMC

" GPS 18¢5H=

After selecting the type of sensor, the following window opens. This is the Main Interface Screen for the program.

To configure your sensor, you must first connect to the 17x sensor.

1. Select Config > Switch to NMEA Mode

= - SNSRCFG - GARMIN Sensor Configuration Softway -0 x|
(OI' press the F10 ke}’) Eile Comm Config Wiew Help -
2. Select Comm > Setup to open the Comm == 83| r|r| = S
Setup Window.
Configuration file: FHERCTE
3 : . GPZ Base Hodel: P2 17x
3. Select the serial port to which the sensor is felested
connected. Select Auto to have the program | Sxzten Senfiquration - fembemaes:
automatically determine the baud rate, or Power Save Mode:  OFf (Normal Mode)  GEGSE
aze Outpu atn: OEf P F3U
select Manual to manually select the baud Frace fukput fat g
rate of the GPS 17x HVS. Click OK when WHER Gonfiguration PGRAT
¥HER 2.30 Hode: LF =3
done. FHEL Ouktput Time: L sec
. . Lel =] PPE Configueration
4. Click the Connect icon 22| or select Comm FPE moda: 1Hs
FFZ Length: 100 msec
> ConneCt' FFS Ruto 0ff: aff
5. To view the current programming of the GPS Confimuration
. Fiu mode: Eutomatic
sensor, select Config > Get Configuration DEPS Hode: WEEE Only
from GPS (or press the F8 key). The current Differantisl mode: Buvonivic
. . 4 . Danmd Besken Timae: 20.0 sec
programming of the sensor is displayed in
. . Latitude: 0o o0 o0nt W
the window shown to the right. Lot bade: 007 D8.000¢ T
Bl tude: 200.0 metecs
Earth datum index: WE3 &2
4
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File Menu
The File Menu allows you to open, save, and print sensor configurations. The items in the File Menu work like most
Windows-based programs.

Comm Menu
The Comm (Communication) Menu allows you to set the port number, baud rate, and then connect and disconnect
from the sensor.

Setup: Opens the Comm Setup Window. Select the serial port to which the x|
sensor is connected from the drop-down list. Then select Auto (the program Serial Port: Baud Fate

determines the baud rate on its own) or Manual (you then enter the baud rate) |—_[ -1 | fuo

for the baud rate entry. " Manual

Connect: Select Connect to connect to the sensor to change or view the oK, I Cered] |

configuration.

Disconnect: Select Disconnect to disconnect from the sensor.

Config Menu . p———— X
The Config (Configuration) Menu allows you Ll SR
configure the sensor as it is connected. — System Configuration
™ Fower Save Mode —
Sensor Configuration (F6): Opens the Sensor Baud Rate: |192|JD v|
. . . ™ Phase Dutput Diata LCancel |
Configuration Window, shown to the right.

Many of the fields in this window should be left
alone. Please refer to the beginning of this

—MNME2 Configuration — Commands
MHEES Output Time

manual for clarification about some of these ™ NMEA 230 Mods = Freset Urit |
fields. For the most part, this window is used to [ II

enter a new latitude, longitude, and altitude for Feset NDnV°||
the sensor. This is especially helpful when you  Pulze-Per-Second [PPS] Configuration

are programming the sensor for use in a e e FPS Length Sem“t':"“atel
particular geographic location. I PPS Auto Off Hode [oo ﬂ S |
Resetting the Unit (Reset Unit) performs a reset

on the unit, much like cycling the power. —GPS Configuration

Resetting the non-volatile memory (Reset Fix Mode: Im Dead Aackon Eaith D atum:

4

NonVol) will clear all of the data from the non- Walid Time W
DGPS Mode: IWMS Oniy VI

volatile memory. P
Diff kM ode I."-‘-.utnmatic 'I [ IES?B'IST-"
DF: |258.257 223563

Lattude: [0 ° [0 'ENCs px: [A
Longtude [0 ° [0 " FIE Clw ov: [0
Altitude: 300 reter DE: IIJ
NMEA Sentence Selections (F7): Displays the NMEA Sentence Selections x|
Window. If the sentence is enabled, a check mark appears in the box to the left of e el

the sentence name. Click the box to enable or disable to the sentence.

] [~ PGRME
¥ GPGSA [~ PGRME
¥ GPGSY [~ PGRMF
¥ GPRMC [ PGRMT
[T GRYTG [~ PGRMY Cancel
[T LCGLL I PGRMM
T eytE T GPGLL k.

Rezet...

A8 IE

190-00885-07 GPS 17x HVS Technical Specifications Rev. B
Page 29



Get Configuration From GPS (F8): Retrieves the current programming from the sensor. The programming is then
displayed in the Main Interface Window.

Send Configuration To GPS (F9): Sends the changes you have made to the programming to the sensor.

Switch to NMEA Mode (F10): Switches the unit to NMEA Mode. The sensor must be in NMEA Mode when
connected to this software.

Switch to Garmin Mode (F11): Switches the unit to Garmin Mode.

Update Software (F12): After you have downloaded a new software version for the sensor, you can update the
sensor with the new software. Select Update Software and then select the file using the Open dialog box. You must
locate both the .rgn file and the updater.exe file.

View Menu
The View Menu allows you to view the NMEA sentences transmitted by the sensor. You can also customize how
the program looks by showing and hiding the Toolbar and Status Bar.

Help Menu

The Help Menu displays the software version and copyright information.

For the latest free software updates (excluding map data) throughout the life of
your Garmin products, visit the Garmin Web site at www.garmin.com.
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